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Հարգելի՛ ուսուցիչ 

 

Խորհուրդ ենք տալիս առաջադրանքները կատարել ըստ հերթականության: 

Ուշադիր կարդացե՛ք յուրաքանչյուր առաջադրանք: Եթե չի հաջողվում որևէ առաջադրանքի 

անմիջապես պատասխանել, ժամանակը խնայելու նպատակով կարող եք դրան 

անդրադառնալ ավելի ուշ: 

Թեստ-գրքույկի  էջերի  դատարկ  մասերը  կարող  եք  օգտագործել  սևագրության  

համար: 

 

 

 



Microsoft Word փաստաթղթի կառուցվածքի մեջ ինչպե՞ս է ազդում ձեռքով 

տեղադրված Page Break-ը բովանդակության դասավորության և հաջորդական 

բաժինների փոփոխությունների վրա։ 
 

1) Page Break-ը ստեղծում է նոր բաժին (Section) և թույլ է տալիս փոխել էջի 

կողմնորոշումը կամ եզրերը հենց հաջորդ էջից 

2) Page Break-ը տեղափոխում է տեքստը հաջորդ էջ՝ առանց պահպանելու 

ընթացիկ բաժնի (Section) բոլոր ձևաչափման կանոնները 

3) Page Break-ը ավարտում է ընթացիկ պարագրաֆը և պարտադիր ձևափոխում 

է այն Heading 1 ոճով 

4) Page Break-ը ապահովում է անցում նոր էջ, բայց չի ստեղծում նոր բաժին 

(Section) և թույլ չի տալիս փոխել հաջորդ էջի կողմնորոշումը կամ եզրերը 

 

 

Ընտրել Excel-ի Goal Seek գործիքի աշխատանքի ճիշտ նկարագրությունը։ 
 

1) Goal Seek-ը ավտոմատ փոխում է բանաձևը, որպեսզի ստանա ցանկալի 

արդյունքը 

2) Goal Seek-ը փոխում է միայն նշված բջջի արժեքը, մինչև բանաձևի արդյունքը 

հասնի օգտատիրոջ սահմանած արժեքին 

3) Goal Seek-ը գտնում է միաժամանակ մի քանի մուտքային փոփոխականների 

օպտիմալ համադրությունը 

4) Goal Seek-ը միաժամանակ փոխում է բանաձևը և նպատակային բջջի արժեքը 

որպեսզի ստանա ցանկալի արդյունքը 

 

 

Ի՞նչ արդյունք կտա բանաձևը Microsoft Excel ծրագրում։ 
 

=COUNTA(A1:A5) 

եթե արժեքներն են՝ 

A1=12, A2="Hello", A3=7, A4="", A5="World" 

1) 3 

2) 4  

3) 5 

4) 2 
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Ի՞նչն է բնորոշ Backend ծրագրավորմանը։ 
 

1) Օգտագործողի ինտերֆեյսի և գրաֆիկական ձևավորման ստեղծումը 

2) Տվյալների մշակումը, բազաների կառավարումը և սերվերի կողմից 

տրամաբանության իրականացումը 

3) Վեբ կայքի գունային սխեմայի և դիզայնի ընտրությունը 

4) Պատկերների և անիմացիաների լավարկումը 

 

Ի՞նչ հիմնական գաղափար է ընկած RAG (Retrieval-Augmented Generation)  

                մոդելի հիմքում։ 
 

1) Մոդելը ստեղծում է պատահական տեքստ առանց արտաքին տվյալների 

2) Մոդելը նախ որոնում է համապատասխան տեղեկատվություն բազայում, 

ապա ստեղծում պատասխանը այդ տվյալների հիման վրա 

3) Մոդելը պատասխանի գեներացման համար օգտագործում է սեփական 

տեղեկատվությունը առանց դիմելու արտաքին ներմուծված աղբյուրներին  

4) Մոդելը օգտագործվում է միայն պատկերների ճանաչման համար 

 

Ո՞ր Bits per Channel (RGB) ռեժիմում են Adobe Photoshop ծրագրի Image > 

Adjustments մենյուի Color Balance, Shadows/Highlights հրամաններ դառնում 

անհասանելի (greyed out): 
 

1) 8 Bits/Channel 

2) 32 Bits/Channel 

3) 16 Bits/Channel 

4) 24 Bits/Channel 

 

Ո՞րն է Slice Tool-ի հիմնական գործառույթը Adobe Photoshop ծրագրում: 
 

1) Նկարից առանձնացնում է հատվածներ ըստ գույների՝ ֆոնը հեռացնելու 

համար:  

2) Նշված հատվածը կտրում և ավտոմատ տեղափոխում է նոր շերտի վրա՝ 

հետագա խմբագրման համար: 

3) Նկարը բաժանում է հատվածների՝ թույլ տալով յուրաքանչյուր հատվածի 

համար կիրառել տարբեր գունային ռեժիմներ (RGB/CMYK): 

4) Նկարը բաժանում է հատվածների՝ հնարավորություն տալով դրանք 

արտահանել որպես առանձին պատկերային ֆայլեր: 
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Եթե Canvas Size հրամանով մեծացրել եք նկարի չափսերը, ո՞ր հրամանը թույլ կտա 

նշելուց հետո դատարկ հատվածները լրացնել՝ վերլուծելով և կրկնելով շրջակա 

պիքսելները: 
 

1) Paint Bucket Tool 

2) Content-Aware Fill 

3) Dodge Fill  

4) Magic Wand Tool 

 

Ո՞րն է Layer Mask-ի և Clipping Mask-ի հիմնական տարբերությունը  

                Adobe Photoshop ծրագրում: 

1) Layer Mask-ը կիրառվում է միայն վեկտորային օբյեկտների վրա, իսկ 

Clipping Mask-ը՝ ռաստերային: 

2) Layer Mask-ը օգտագործում է սև-սպիտակ գույների թափանցիկության 

համար, իսկ Clipping Mask-ը օգտագործում է ներքևի շերտի ձևը և 

թափանցիկությունը: 

3) Clipping Mask-ը ջնջում է պիքսելները, իսկ Layer Mask-ը պահպանում է 

դրանք: 

4) Layer Mask-ը լուսանկարների հետ է աշխատում, իսկ Clipping Mask-ը՝ միայն 

տեքստային շերտերի։ 

 

Ո՞ր հրամանն է Adobe Photoshop ծրագրում անհրաժեշտ նախապես կիրառել 

շերտի վրա, որպեսզի հնարավոր լինի այն բազմակի անգամ փոքրացնել և 

մեծացնել՝ առանց պատկերի որակը կորցնելու: 

1) Flatten Visible 

2) Rasterize Layer Object 

3) Convert to Smart Object 

4) Merge Visible  

 

Ի՞նչ է տեղի ունենում Adobe Illustrator ծրագրում օբյեկտի հետ, երբ կիրառվում է 

                Expand Appearance հրամանը: 

1) Օբյեկտը ամբողջությամբ վերածվում է ռաստերային պատկերի՝ կորցնելով 

իր վեկտորային հատկությունները 

2) Օբյեկտի էֆեկտներն ու եզրագծերը տրոհվում են՝ վերածվելով առանձին 

խմբագրելի վեկտորային ձևերի 

3) Օբյեկտի բոլոր առանձին մասերը միաձուլվում են՝ դառնալով մեկ 

ընդհանուր անբաժանելի եզրագիծ 

4) Օբյեկտի չափսերը ավտոմատ մեծանում են՝ հարմարեցվելով 

աշխատանքային տիրույթի սահմաններին 
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Adobe Illustrator ծրագրում ո՞ր ֆունկցիան է թույլ տալիս ռաստերային պատկերը  

               ավտոմատ վերածել վեկտորային գծերի: 

1) Rasterize Image 

2) Image Trace 

3) Clipping Image 

4) Flatten Trace  

 

Ո՞րն է Adobe Illustrator ծրագրում Blend Tool-ի և Gradient Tool-ի հիմնական 

              տարբերությունը։ 

1) Gradient Tool-ը աշխատում է միայն ռաստերային նկարների վրա, իսկ Blend 

Tool-ը՝ վեկտորային օբյեկտների վրա 

2) Gradient Tool-ը փոփոխում է օբյեկտի երկրաչափական ձևը, իսկ Blend Tool-

ը՝ միայն գույնը 

3) Gradient Tool-ը կիրառվում է Bitmap օբյեկտների վրա, իսկ Blend Tool-ը՝ HSL 

օբյեկտների վրա 

4) Gradient Tool-ը ստեղծում է գունային անցում մեկ օբյեկտի ներսում, իսկ 

Blend Tool-ը՝ երկու և ավելի օբյեկտների միջև 

 

Adobe Illustrator ծրագրում ի՞նչ ֆունկցիա է կատարում Eyedropper Tool-ը: 

1) Վերցնում է միայն օբյեկտի գույնի կոդը (RGB/CMYK)՝ անտեսելով 

եզրագծերը և էֆեկտները 

2) Խառնում է երկու գույները իրար՝ ստեղծելով նոր երանգ 

3) Ընդօրինակում է օբյեկտի ձևավորման հատկությունները՝ գույն, եզրագիծ, 

էֆեկտներ և կիրառում դրանք մեկ այլ օբյեկտի վրա 

4) Հաշվարկում է նշված հատվածի պիքսելների միջին գունային արժեքը՝ 

նկարի որակը բարելավելու համար 

 

Ինչպե՞ս կարելի է միացնել երկու առանձին բաց եզրակետերը՝ դրանք դարձնելով 

մեկ միասնական փակ կամ շարունակական ուղի Adobe Illustrator ծրագրում: 

1) Object > Group  

2) Object > Path > Join 

3) Object > Merge 

4) Object > Compound Path > Make 
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Աքսոնոմետրիկ պրոյեկցիայի ո՞ր տեսակի դեպքում են առանցքներից երկուսի 

               մասշտաբային գործակիցները հավասար, իսկ երրորդինը՝ դրանցից տարբեր: 
 

1) Իզոմետրիկ պրոյեկցիա 

2) Դիմետրիկ պրոյեկցիա 

3) Տրիմետրիկ պրոյեկցիա 

4) Կովալյեր պրոյեկցիա 

 

3D գրաֆիկայում ո՞ր գործընթացն է պատասխանատու մաթեմատիկական  

                մոդելը (Wireframe) վերջնական պիքսելային պատկերի (Image/Video)  

                վերածելու համար։ 
 

1) Vectorization 

2) Rendering 

3) Texture Baking 

4) Polygon Optimization 

 

Ի՞նչ է անում Clip Content ֆունկցիան Figma ծրագրում: 
 

1) Ավտոմատ կերպով կտրում է Frame-ի պարունակությունը՝ դարձնելով այն 

շրջանաձև տեսքի 

2) Թաքցնում է Frame-ի սահմաններից դուրս եկող ցանկացած հատված 

3) Frame-ի տարբեր պարունակություն ունեցող շերտեր միավորում է մեկ 

շերտի մեջ 

4) Արգելափակում է Frame-ի չափսերի փոփոխությունը 

 

Figma ծրագրում ի՞նչ տարբերություն կա Group (Ctrl+G) և Frame (Ctrl+Alt+G)  

                հասկացությունների միջև: 
 

1) Group-ը ավտոմատ կերպով միաձուլում է բոլոր շերտերը մեկ ռաստերային 

պատկերի, իսկ Frame-ը թույլ է տալիս պահպանել դրանց վեկտորային 

կառուցվածքը խմբագրման համար 

2) Frame-ը հանդիսանում է ֆունկցիոնալ տարածք, որն ունի անկախ 

սեփական հատկություններ, իսկ Group-ի սահմանները որոշվում են միայն 

իր մեջ գտնվող օբյեկտներով 

3) Group-ը թույլ է տալիս ստեղծել Layout Grid-եր և կառավարել ադապտիվ 

դիզայնը, իսկ Frame-ը նախատեսված է բացառապես ստատիկ օբյեկտները 

պարզապես իրար կպցնելու համար 

4) Frame-ը օգտագործվում է միայն որպես էկրան Prototype ռեժիմի համար և 

չի կարող դրվել մեկ այլ Frame-ի ներսում, իսկ Group-ը՝ կարող է 
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Ի՞նչ արժեք կարտածի հետևյալ Python կոդը: 

a = 56   

b = 3   

result = a << b   

print(result) 
 

1) 168 

2) 228 

3) 448 

4) 668 

 

 

 

 

Տրվածներից ո՞ր 3 պնդումներն են ճիշտ։Նշել դրանց համարները։ (3 միավոր) 

1. Adobe Photoshop ծրագրում Smart Object-ի վերածված շերտը պահպանում է 

ֆայլի օրիգինալ տվյալները՝ թույլ տալով բազմակի անգամ փոքրացնել և 

մեծացնել այն առանց որակի կորստի։ 

2. Որակական հետազոտության (Qualitative Research) հիմնական նպատակը 

կայքի HTML/CSS կոդի սխալների հայտնաբերումն է։ 

3. A/B թեստավորումը նշանակում է կայքի A տարբերակի ստուգում Android 

համակարգով, իսկ B տարբերակի ստուգում՝ iOS համակարգով։  

4. Adobe Illustrator ծրագրում Perspective Selection Tool-ը թույլ է տալիս 

օբյեկտները տեղաշարժել հեռանկարային (Perspective) ցանցի վրա: 

5. Adobe Illustrator ծրագրում Live Paint Bucket-ը ավտոմատ ստեղծում է 

Clipping Mask 

6. Adobe Illustrator ծրագրում  Shape Builder Tool-ը թույլ է տալիս միավորել 

օբյեկտները: 

7. Usability Testing-ի հիմնական նպատակը կայքի գունային գամմայի 

գեղագիտական գնահատումն է արվեստի տեսանկյունից։ 

8. UI դիզայնը զբաղվում է տվյալների բազայում օգտատերերի անձնական 

տվյալների պահպանման ալգորիթմներով։  

9. Որակական հետազոտությունը կենտրոնանում է գնորդների ֆինանսական 

եկամուտների հաշվարկման վրա։  
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Տրվածներից ո՞ր 3 պնդումներն են ճիշտ։Նշել դրանց համարները։ (3 միավոր) 

1. Wireframe-ը կայքի կամ հավելվածի սկզբնական նախագիծն է, որտեղ նշվում 

են էլեմենտների դիրքերը՝ առանց դիզայնի գունային մանրամասների։ 

2. Agile-Sprint-ը համակարգչային հատուկ ծրագիր է, որը նախատեսված է 

վերջնական դիզայնը մշակելու համար։ 

3. UI դիզայնում 8px ցանցային համակարգը (Grid system) օգտագործվում է 

միայն տառաչափերը որոշելու համար։  

4. Figma-ում Plugin-ները խթանում են դիզայնի գործընթացը՝ ծրագրին 

ավելացնելով նոր հնարավորություններ, գործառույթներ և 

ավտոմատացում։ 

5. Տեքստի հիերարխիան ձևավորվում է միայն կայքի սերվերային (Back-end) 

փուլում՝ Markdown ծրագրավորման լեզվի միջոցով։ 

6. Wireframe-ը ներկայացնում է նախագծի վերջնական տեսքը՝ ներառյալ 

բրենդային գույները, ոճերը և բոլոր լուսանկարները։ 

7. Prototype-ը դիզայնի ինտերակտիվ մոդելն է, որը թույլ է տալիս 

սիմուլյացնել օգտատիրոջ գործողությունները, էջերի անցումները և 

անիմացիաները՝ նախքան ծրագրավորումը։ 

8. Տեքստի հիերարխիան ենթադրում է, որ բոլոր տեքստերը պետք է լինեն 

նույն չափսի և գույնի՝ դիզայնի պարզությունը պահպանելու համար։ 

9. A/B թեստավորումը իրականացվում է A – գրաֆիկական և B – տեքստային 

մասերի աշխատանքը առանձին ստուգելու համար։ 

 

 

Նշվածներից ո՞ր 3 պնդումներն են ճիշտ Python-ի կլաս-ի(Classes) և Objects  

              վերաբերյալ: (3 միավոր) 

1. Կլասը ձևանմուշ է (template), որով ստեղծվում են օբյեկտներ։ 

2. Օբյեկտները չեն կարող ունենալ տարբեր արժեքներ նույն ատրիբուտի 

համար։  

3. Կլասը չի կարող պարունակել տվյալներ (ատրիբուտներ)։  

4. Բոլոր օբյեկտները պարտադիր ունեն նույն վարքագիծը։  

5. Կլասները հնարավոր չէ սահմանել դատարկ (pass հրամանով)։  

6. Կլասի անունները պետք է լինեն ամբողջությամբ փոքրատառ։  

7. Օբյեկտը հնարավոր չէ ստեղծել առանց պարամետրերի։  

8. Օբյեկտը կոնկրետ օրինակ (instance) է այդ կլասից։ 

9. Կլասի ներսում ֆունկցիաները կոչվում են մեթոդներ։ 
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Նշվածներից ո՞ր 3 պնդումներն են ճիշտ վեբ ծրագրավորման (Advanced Web  

               Development) վերաբերյալ։ (3 միավոր) 

1. REST API-ն (Representational State Transfer) օգտագործվում է սերվերի և 

հաճախորդի միջև տվյալների փոխանակման համար։ 

2. AJAX տեխնոլոգիան օգտագործվում է բացառապես CSS ոճերը դինամիկ 

կերպով փոփոխելու համար։ 

3. JSON ձևաչափը (JavaScript Object Notation) օգտագործվում է տվյալների 

կառուցվածքային փոխանակման համար։ 

4. Framework-ները (օր.՝ Django, React, Angular) արագացնում են վեբ 

հավելվածների մշակումը։ 

5. CSS-ը համարվում է backend լեզու։  

6. Node.js-ը նախատեսված է միայն frontend ծրագրավորման համար։ 

7. API ինտերֆեյսները թույլ չեն տալիս ծրագրերին հաղորդակցվել միմյանց 

հետ։ 

8. SQL հարցումները կիրառվում են միայն frontend-ում։  

9. HTML լեզուն հիմնականում նախատեսված է BackEnd ծրագրերի մշակման 

համար։ 

 

 

Նշվածներից ո՞ր 3 պնդումներն են ճիշտ կիրառական հավելվածների ստեղծման  

              միջոցների վերաբերյալ։ Նշել դրանց համարները։ (3 միավոր) 

 

1. Կիրառական հավելվածները միշտ աշխատում են միայն օֆլայն (առանց 

ինտերնետի)։  

2. Հավելված ստեղծելու համար պարտադիր է ունենալ օպերացիոն 

համակարգի աղբյուրային կոդը։  

3. IDE միջավայրերը չեն ապահովում ծրագրի փորձարկում։ 

4. Կիրառական հավելվածը նախատեսված է կոնկրետ գործնական խնդրի 

կամ ծառայության իրականացման համար։ 

5. Կիրառական հավելվածների ստեղծման համար կարող են օգտագործվել 

միջավայրեր, ինչպիսիք են՝ Visual Studio, PyCharm, Eclipse։ 

6. Կիրառական հավելվածները լինում են BackEnd, WithoutEnd, FrontEnd։  

7. Կիրառական հավելվածների մշակման գործընթացում կիրառվում են 

ինտերֆեյսների և տվյալների բազաների ինտեգրում։ 

8. Կիրառական հավելվածների մշակումը պահանջում է միայն 

ծրագրավորման հմտություններ։  

9. Կիրառական հավելվածը նույնն է, ինչ օպերացիոն համակարգը։  
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Նշվածներից ո՞ր 3 պնդումներն են ճիշտ գունային համադրությունների  

               վերաբերյալ:  (3 միավոր) 

1. Analogous գույները գունային շրջանակում գտնվում են միմյանց կողքի։ 

2. Monochromatic համադրությունը պարունակում է միմյանց հակադիր 

գույներ։ 

3. Tetradic համադրությունը կազմված է ընդամենը երեք գույնից։ 

4. Split-Complementary գույները կազմվում են մեկ գույնի և նրա հակադիրի 

երկու հարևան գույներից։ 

5. Tonal գույները կազմված են միայն ամենավառ և հագեցած երանգներից։ 

6. Square սխեման միավորում է իրար կողք գտնվող չորս գույները։ 

7. Triadic գույները հավասարաչափ տեղադրված են գունային շրջանակում։ 

8. Achromatic համադրությունը ներառում է գունային շրջանակի բոլոր տաք 

գույները։ 

9. Complementary գույները գունային շրջանակի վրա գտնվում են 90° անկյան 

տակ։ 

 

 

 

Նշվածներից ո՞ր 3 պնդումներն են ճիշտ HTML/CSS-ի վերաբերյալ։ (3 միավոր) 
 

1. HTML-ի <ol> թեգը օգտագործվում է համարակալված ցուցակներ ստեղծելու 

համար։ 

2. CSS-ի font-size հատկությունը փոխում է տառատեսակի գույնը։ 

3. HTML-ի <input type="password"> թեգը թաքցնում է մուտքագրվող նիշերը։ 

4. CSS-ի margin հատկությունը ավելացնում է տարածություն օբյեկտի 

սահմաններից ներս։ 

5. HTML-ի <br> թեգը օգտագործվում է տեքստը թավ դարձնելու համար։ 

6. CSS-ի text-decoration հատկությունը սահմանում է տեքստի գծային 

ձևավորումը: 

7. HTML-ի <head>  թեգը պարունակում է էջի հիմնական տեսանելի 

բովանդակությունը։ 

8. CSS-ի type հատկությունը փոխում է տառատեսակի անվանումը։ 

9. CSS-ի display: block; հատկությունը տարրը դարձնում է inline և թույլ է տալիս 

դասավորել նույն տողում։ 
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Նշվածներից ո՞ր 3 պնդումներն են ճիշտ HTML/CSS-ի վերաբերյալ: (3 միավոր) 

1. CSS-ի border-radius հատկությունը օգտագործվում է տարրի անկյունները 

կլորացնելու համար։ 

2. HTML-ի <span> թեգը բլոկային տարր է և միշտ սկսվում է նոր տողից: 

3. CSS-ի font-family հատկությունը որոշում է տեքստի տառատեսակը✅ 

4. CSS-ի position: fixed; հատկությունը ֆիքսում է տարրը էկրանի վրա՝ անկախ 

էջը թերթելուց։ 

5. CSS-ի z-index հատկությունը փոխում է օբյեկտի թափանցիկությունը։ 

6. HTML-ի <link> թեգը օգտագործվում է էջում նկար տեղադրելու համար։ 

7. CSS-ի width հատկությունը փոխում է օբյեկտի գունային ֆոնը։ 

8. HTML-ի <hr> թեգը ստեղծում է հիպերհղում դեպի այլ էջ։ 

9. CSS-ի background-image հատկությունը փոխում է տեքստի գույնը։ 

 

 

 

Նշված տարբերակներից ո՞ր 3-ն են ճիշտ CSS-ում h1 վերնագիրը կենտրոնացնելու, 

2px հաստությամբ կապույտ հոծ եզրագիծ և կապույտ տեքստ ստանալու համար։ 

Նշել դրանց համարները։ (3 միավոր) 

1. h1 { text-align: center; border: 2px solid blue; color: blue; } 

2. h1 { align: center; border: 2px solid blue; font-color: blue; } 

3. h1 { text-align: center; border: 2px solid blue; color: rgb(0, 0, 255); } 

4. h1 { text-position: center; border: 2px solid blue; color: #0000FF; } 

5. h1 { text-align: center; border: 2px solid #0000FF; color: #0000FF; } 

6. h1 { text-align: middle; border-size: 2px; border-color: blue; color: blue; } 

7. h1 { text-align: center; border-weight: 2px; color: blue; } 

8. h1 { text-align: center; border: 2px blue; color: blue; } 

9. h1 { font-align: center; border: 2px solid blue; text: blue; } 
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Նշվածներից ո՞ր 3 պնդումներն են ճիշտ Python-ի պայմանական  

       օպերատորների (if, elif, else) վերաբերյալ։ (3 միավոր) 

1. Եթե if պայմանը կեղծ է (False), ապա, առկայության դեպքում, else բլոկը 

միշտ կկատարվի։ 

2. else պետք է պարտադիր պարունակի պայման։ 

3. Պայմանական հրամանները չեն կարող տեղադրվել միմյանց ներսում։  

4. Պայմանական հրամանը կարող է օգտագործվել միայն թվային արժեքների 

համար։ 

5. if հրամանը չի կարող օգտագործվել առանց else-ի։ 

6. if հրամանը օգտագործվում է, երբ պետք է ստուգվի որոշ պայման։ 

7. elif նշանակում է “else if” և օգտագործվում է՝ երբ պետք է ստուգվի 

լրացուցիչ պայման։ 

8. Եթե մի քանի պայման ճշմարիտ է, Python-ը կատարում է բոլոր ճշմարիտ 

բլոկները։ 

9. elif կարող է օգտագործվել առանց նախորդ if հրամանի։  
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